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Instructor's Notes

Exploring Microsoft Office 2003
Explain to students that Microsoft Office 2003, or Office, is a collection of the most popular Microsoft programs. These programs share many features and therefore, it's easy to share information among them. The primary programs are:

· Word: word-processing program used for creating documents

· Excel: spreadsheet program use to display, organize, and analyze numerical data

· PowerPoint:  presentation graphics program used to create a collection of slides that will be used during a presentation

· Access: database program used to enter, organize, display, and retrieve related information

· Outlook: information management program used to send, receive, and organize e-mail and other management tasks. 
Take the time to open each of these applications and explore them with the students illustrating with example files, if possible, how the Office programs provide you with many different ways of organizing and sharing information.  Explain that Office is a complete set of tools that can be used independently or can be combined.
Explore the benefits of integrating data between programs
Show students how one of the main advantages of Office is integration, which enables you to share information between programs. Integration ensures consistency and saves time because you don't have to re-enter the same information in documents created in different Office programs.

Use the list of examples that appears on page OFF 5 to help students grasp the concepts of integration.  These examples provide “real world” situation in which integration is applied.
Quick Quiz: 

1. Which of the following Office programs enables you to display, organize, and analyze numerical information? (Answer: b)
a. Word

b. Excel

c. Access

d. PowerPoint

2. _______________ is the Office program that enables you to perform organization tasks. (Answer: Outlook)
3. True/False: PowerPoint presentations can be shown on your computer monitor, projected onto a screen as a slide show, printed, shared over the Internet, or displayed on the World Wide Web. (Answer: True)
Classroom Activity:

Divide the class into small groups.  Each group should pretend that they are a team working for the sales department of a large corporation.  The team has been asked to create a report that details the sales data for the past quarter.  The report will include two parts: a written report and a presentation to the board of trustees.  Have the groups decide how they would use each of the applications in the Office suite to create this report.  Make sure they include Outlook as an email and scheduling tool.  After they have completed their discussion, have each team report back to the rest of the class.
Starting Office Programs
Show students the various ways to open a program.  Explain that you can:

· Click the Start button on the Windows taskbar and then use the Programs menu
· Click the New Office Document command
· Open Office Document command on the Start menu. 

· If a user has recently used the program you want to open, the program may appear on the most frequently used program list (left side of Start Menu).  In that case, you can just click the entry and the program will open.

The text mentions the option of using the Open Office Document from the Start menu but then it is not practiced and it is not mentioned later in the text when opening files is discussed. You, therefore, need to make a point of tying this information together and making sure that they understand the multiple ways of opening existing documents (i.e., illustrate the different ways of opening the programs).
Switching Between Open Program and Files

Be sure students understand that they can switch back and forth between open programs easily by clicking the program button on the taskbar.  Use Figure 4 to show the button for active programs.  You might also consider showing students how to use ALT-TAB to scroll through open programs.
Quick Quiz: 

1. The ability of Office application to integrate ensures which of the following? (Answer: d)
a. Neatness.

b. Stability

c. Predictability

d. Consistency

2. To add names and address to a form letter, you can integrate either Outlook or Access with _____________. (Answer: Word)
3. True/False: Office enables you to integrate an Excel chart into a PowerPoint Presentation. (Answer: True)
Exploring Common Window Elements

Use Figure 5 to go over the common window elements seen in most Windows applications.  Explain that this makes it easy to pick up and new application and learn it quickly because many of the elements are already familiar.  
Using the Window Sizing buttons

It is very important that students learn how to use these buttons.  Make sure students understand that there is a set of sizing button for the application and another set for the open file.  Use Figure 6 to show the distinction between the two.  Also explain that the Maximize button and the Restore button are in the same place.  When a window is maximized, the middle button is the Restore button.  However, when the window is not maximized (i.e., smaller then full screen), the middle button is the Maximize button.

Beginning users will usually work in a maximized window.  However, explain that there will be times when a user will want to work with two (or more) programs at a time and being able to size the windows down will make it possible for see both at the same time.
Using Menus and Toolbars
Some students may be unfamiliar with menus and toolbars so you need to take the time to explain what they are and how they are used. In each Office program, you perform tasks using a menu command, toolbar button, or keyboard shortcut. A menu command is a word on a menu that you click to execute a task; a toolbar is a collection of buttons that correspond to commonly used menu commands; and keyboard shortcuts are combinations of keys you press to perform a command. 

Once you explain menus and toolbars, you need to explain that the menus and toolbars in each Office 2003 program can change to "learn" your preferences. As you select menu commands and click toolbar buttons, the ones you use often are put on the short personal menu and on the visible part of the toolbars. The ones you don't use are hidden, but remain available through the double-arrow button on the menu and the Toolbar Options button on the toolbars.

This is sometime frustrating to a new user because they do not see the commands they are looking for.  Use Figure 7 and 8 to show how the menus are short (Figure 7) but can be expanded (Figure 8) when it is desirable to do so.  Also use Figure 8 to show the keyboard shortcuts, the ellipses, and submenu arrows.  If you can, illustrate all of these on your screen display.
Quick Quiz:

1. To turn off personalized toolbars, you need to select which of the following? (Answer: a)
a. Show Buttons on Two Rows command from the Toolbar Options button.

b. Commands tab in the Customize dialog box.

c. Toolbars tab in the Customize dialog box.

d. You cannot turn off personal menus and toolbars.
2. A group of related commands is a(n) ____________. (Answer: menu)
3. True/False: To select the menu commands you use most often, you need to use the double arrow button on the menu. (Answer: False)
Using Task Panes

You should go over the list of common task panes listed in Figure 10.  Explain that these task panes will be available in all the Office programs.  Also explain that some of the programs will have additional task panes that are pertinent only to that program.  
Use Figure 11 to show the different elements that appear on the Getting Started task pane.  Make sure students understand how to open and close the task panes.  Explain that sometimes they will want the task pane open and sometimes (when they don’t need it) they will want to close it to allow for more room in the document window.

Be sure students understand the techniques for navigating the task panes.  These procedures are covered on page OFF 16.  
Working with Files
One of the most important topics for students of this tutorial is saving their work - without this information the Office programs are of little use. Explain to students that to keep a copy of their work for future use (instead of having it erased when they close the program or turn off their computer), they need to save it by giving it a filename. 
A filename should be descriptive of the content of the file. Each filename will automatically have a file extension added that identifies the program in which the file was created. In addition to the filename you will need to choose where you'll save the file (i.e., on which disk and in what folder). All of these choices are made in the Save As dialog box.

Make sure students understand the difference between Save and Save As.  Also stress the importance of saving files on a regular basis so that work is not lost in the case of power failure or some other interruption in the computer.

Opening a File

Explain to students that once they have opened a program they can create new files or open existing ones. Files can easily be created or opened through the New Task Pane (the exact name on this pane will vary depending upon the program in use). Show students examples of the various New Task Panes in the different Office programs.

Figure 15 illustrates the Open dialog box.  Be sure students understand that they must first navigate the “Look in” text box to the location of the file they want to open.  Also explain that the files displayed will depend on what is shown in the “Files of type:” box.  Consider illustrating this concept on your own computer.  First display only Word documents then change the file type to All files to illustrate how this affects the file list. 

Make sure that students understand that when they open a previously created file, they transfer a copy of the file from the storage disk to the computer's memory and it displays on the screen. While a file is open, you can view, edit, print or resave it.

Again, explain to students that there are multiple ways of achieving the same task and that once they have saved their work, they can close the file by clicking the Close command on the File menu or the Close Window button on the menu bar.
Quick Quiz:

1. You can save a file by clicking which of the following? (Answer: d)
a. The Folder button on the Standard toolbar.

b. The Save button on the Formatting toolbar.

c. The Folder button on the Formatting toolbar.

d. The Save button on the Standard toolbar.

2. A(n) _______________ identifies the program in which a file was created. (Answer: file extension)
3. True/False: Edits and additions you make to a file are automatically saved. (Answer: False)
Getting Help

This is an extremely important section for the students so you need to make sure that they clearly understand how to use the various Help features. With a firm understanding of how to use Help they can then go on to explore and learn the Office programs on their own. Explain how Office Help is like a huge encyclopedia stored on the computer that contains information on how to use Office. To use Help, you can use the What's This? option within the Help menu. When this option is selected, you can get a brief description of any item on your screen by clicking your mouse pointer on it. If you want to know a button's name, you can move the mouse pointer over it to view its ScreenTip, which is a yellow box with the button's name. 

It is a useful activity to have students hover their pointer (mouse) over each button on the menus and toolbar.  Have students read each ScreenTip that is displayed.  

Thoroughly cover the elements shown in the Help task pane shown in Figure 17.  Explain and illustrate how students can get information through the search features of help.  Use Figure 18 to illustrate how they can use their search results to find exactly what they are looking for.

Finally, make sure to show students the Office on Microsoft.com website where they can find all kinds of useful information.  It is a good activity for students to simply browse the different links at this site and see what they can learn.
Quick Quiz: 

1. If you want a brief description of a dialog box option, you can use which of the following? (Answer: a)
a. The What’s This? Command

b. A Screen Tip

c. The Office Assistant

d. An Encyclopedia

2. If you want to know a button’s name, you can position the mouse pointer over the button to view its ____________.  (Answer: Screen Tip)
3. True/False: The Ask a Question box is a fast and simple way to find out what a toolbar button does. (Answer: False)
Classroom Activity:

In groups of two students per computer, have students explore the use of the Office Assistant.  You may need to give them some guidance and also give suggestions as to questions they might ask the Office Assistant.  If you can, give each group a different question to ask.  Preferably, the questions would pertain to topics you plan to cover in this course.  After allowing 5- 10 minutes for the activity, have the groups report what they learned and also have them evaluate whether the Office Assistant was easy to use.
Printing a File
Explore with students the two ways to print a file on which you are working. One is to simply press the Print button on the Standard toolbar. You need to explain that this will automatically send the file to the printer using all the default settings and emphasize that they will not be given the opportunity to make any changes or adjustments to how or what is printed.

Then explain that the other way to print is to select Print on the File menu. This will open the Print dialog box in which you can adjust the printer settings. This is the preferred method if you are unsure of your settings or need to make adjustments. It is recommended that you use this method the first time you print during each computer session.

It may also be useful at this point to discuss using Print Preview with the students. Explain that this allows them to see exactly what will appear when they print - and hence make any necessary changes before they print.  This will save paper and ink, as well as time.
Quick Quiz:

1. What menu is the Print option found on? (Answer: d)
a. Tools

b. Edit

c. Standard

d. File

2. One way to print your file is to click the ___________ button on the Standard toolbar. (Answer: Print)
3. True/False: The Print dialog box gives you an option to print a portion of your file. (Answer: True)
Exiting Programs
Explain to students that whenever they finish working with a program, they should close it. Closing programs after using them keeps your Windows desktop uncluttered, frees up your system's resources, and prevents data from accidentally being lost. You can exit most programs by clicking the Close button in the upper-right corner of the title bar, or by selecting the Exit command on the File menu. Either method will close both the file in which you are working as well as the program. (If you have made any edits to a file, a dialog box will appear asking if you want to save your changes.) 

Tutorial Discussion Questions

1. How have software programs (such as those available in Office 2003) replaced traditional methods of accomplishing tasks in an office? In what ways can these types of programs make tasks easier?  What are some potential hazards of working with electronic files for important office documentation?

2. Have you heard of any other program packages (or suites) that have a collection of programs designed for accomplishing common tasks such as composing reports, analyzing data, or preparing presentations? Do you think these packages would also offer integration?  Why is integration so important for electronic files?

3. How important do you think it is to have an effective Help system that is easy to use and easy to understand?  Have you ever used a program that provided little or no help?  If so, did you find it frustrating?  Based on what you have seen so far, do you think Microsoft has done a good job of providing Help in the Office suite?  How could it be improved?  Do you prefer the Help system or the Office Assistant?

Key Terms
	Term
	Definition

	Ask a Question box
	A box located on the menu bar of every Office program and is used to find information in the Help system

	Databases
	The file you create in access

	Documents
	The files you create in Word.

	File Extension
	The part of the file name that identifies the program in which the file was created

	Filename
	A name assigned to a file that is used to identify the file

	Folder
	A container for files

	Help
	Information on how to perform tasks

	Help Task Pane
	A task pane that enables you to search the Help system using keywords or phrases.

	Integration
	The ability to share information between program

	Keyboard shortcut
	A combination of keys you press to perform a command

	Menu
	A group of related commands

	Menu Command
	A word on a menu that you click to execute a task

	Microsoft Access 2003 (Access)
	A database program you use to enter, organize, display, and retrieve related information

	Microsoft Excel 2003 (Excel) 
	A spreadsheet program you use to display, organize, and analyze numerical data

	Microsoft Office 2003 (Office)
	A collection of the most popular Microsoft programs: Word, Excel, PowerPoint, Access, and Outlook.

	Microsoft Outlook (Outlook)
	An information management program you use to send, receive, and organize e-mail; plan your schedule; arrange meetings; organize contact; create a to-do list; and jot down notes.

	Microsoft PowerPoint 2003 (PowerPoint)
	A presentation graphics program you use to create a collection of slides that can contain text, charts, pictures, and so on.

	Microsoft Word 2003 (Word)
	A word-processing program you use to create text documents.

	Office on Maicrosoft.com
	A web site maintained by Microsoft that provides access to additional Help resources.

	Presentation
	The files you create in PowerPoint

	ScreenTip
	A yellow box that contains a button’s name

	Task pane
	A window that provides access to commands for common task you will perform in Office programs

	Toolbar
	A collection of buttons that correspond to commonly used menu commands

	Workbooks
	The files you create in Excel
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